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Notes:

1. Commands (and constants) are shown without the

    gl (or GL_) prefix.

2. The following commands do not appear in this

    diagram: glAccum, glClearAccum, glHint,

    display list commands, texture object commands,  

    commands for obtaining OpenGL state 

    (glGet commands and glIsEnabled), and

    glPushAttrib and glPopAttrib.  Utility library

    routines are not shown.

3. After their exectution, glDrawArrays and

    glDrawElements leave affected current values

    indeterminate.

4. This diagram is schematic; it may not directly

    correspond to any actual OpenGL implementation.

Convert

normal coords

 to float

Enable/Disable

TexSubImage

CopyPixels

CopyTexImage

CopyTexSubImage

PolygonOffset

LineWidth

Enable/Disable

(Antialiasing)

EdgeFlagPointer

TexCoordPointer

ColorPointer

IndexPointer

NormalPointer

VertexPointer

InterLeavedArrays

 EnableClientState

DisableClientState

DrawElements

ArrayElement

Vertex

Array

Control

t     0

r     0

q     1

A     1

z      0

w     1

Key to OpenGL Operations

Primitives Fragments

Vertices

Feedback

&

Selection

Input

Conversion

&

Current

Values

Texture Coordinate

Generation

Evaluators

&

Vertex Arrays

Lighting

Matrix

Control
Clipping, Perspective,

and

Viewport Application
Rasteriz!

ation Texturing,

Fog,

and

Antialiasing

Per!Fragment Operations

Frame Buffer

&

Frame Buffer ControlPixels

DrawArrays

www.opengl.org
Open Graphics Language

Portuesi Simone

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

www.opengl.org
Open Graphics Language

Roma Tre, DIA, Informatica Grafica AA 2006

Portuesi SimoneEsercitazione1/3/2005



Oggi

Cos’è OpenGL

Modello

Librerie Associate

Primo Programma

Trasformazioni

Secondo Programma ... 



Prossime Lezioni

08/03 : Primitive OpenGL
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22/03 : Texture mapping
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Cos’è OpenGL?

API per il rendering grafico
(API: Application Programming Interface)

Immagini di alta qualità costruite da 
primitive d’immagine e geometriche

Indipendente da Hardware, Sistema 
Operativo, e Sistema Grafico

What You See is What You Wanted
Quello che ottieni è quello che hai detto
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(può essere implementato in hardware vero)
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Figure 1. Block diagram of OpenGL.

missing features. This may complicate the application because of

interaction between the two APIs.

On the other hand, if an implementation of the API provides cer-

tain features on one hardware platform, then, generally speaking,

those features should be present on any platform on which the API

is provided. If this rule is broken, it is difficult to use the API in a

program that is certain to run on diverse hardware platforms without

remembering exactly which features are supported on which ma-

chines. In platformswithout appropriate acceleration, some features

may be poor performers (because they may have to be implemented

in software), but at least the intended image will eventually appear.

3.4 Interoperability

Many computing environments consist of a number of computers

(often made by different companies) connected together by a net-

work. In such an environment it is useful to be able to issue graphics

commands on one machine and have them execute on another (this

ability is one of the factors responsible for the success of X). Such

an ability (called interoperability) requires that the model of execu-

tion of API commands be client-server: the client issues commands,

and the server executes them. (Interoperability also requires that the

client and the server share the same notion of how API commands

are encoded for transmission across the network; the client-server

model is just a prerequisite.) Of course the client and the server

may be the same machine.

Since API commands may be issued across a network, it is im-

practical to require a tight coupling between client and server. A

client may have to wait for some time for an answer to a request

presented to the server (a roundtrip) because of network delays,

whereas simple server requests not requiring acknowledgement can

be buffered up into a large group for efficient transmission to and

execution by the server.

3.5 Extensibility

As was discussed in the introduction, a 3D graphics API should,

at least in principle, be extendable to incorporate new graphics

hardware features or algorithms that may become popular in the

future. Although attainment of this goal may be difficult to gauge

until long after the API is first in use, steps can be taken to help

to achieve it. Orthogonality of the API is one element that helps

achieve this goal. Another is to consider how the API would have

been affected if features that were consciously omitted were added

to the API.

3.6 Acceptance

It might seem that design of a clean, consistent 3D graphics API

would be a suficient goal in itself. But unless programmers decide

to use the API in a variety of applications, designing the API will

have served no purpose. It is therefore worthwhile to consider the

effect of design decisions on programmer acceptance of the API.

4 Design Features

In this sectionwe highlight the general features of OpenGL’s design

and provide illustratations and justifications of each using specific

examples.

4.1 Based on IRIS GL

OpenGL is based on Silicon Graphics’ IRIS GL. While it would

have been possible to have designed a completely new API, expe-

rience with IRIS GL provided insight into what programmers want

and don’t want in a 3D graphicsAPI. Further, makingOpenGL sim-

ilar to IRIS GL where possible makes OpenGL much more likely

to be accepted; there are many successful IRIS GL applications,

and programmers of IRIS GL will have an easy time switching to

OpenGL.

4.2 Low-Level

An essential goal of OpenGL is to provide device independence

while still allowing complete access to hardware functionality. The

API therefore provides access to graphics operations at the lowest

possible level that still provides device independence. As a result,

OpenGLdoes not provide a means for describing or modeling com-

plex geometric objects. Another way to describe this situation is

to say that OpenGL provides mechanisms to describe how com-

plex geometric objects are to be rendered rather than mechanisms

to describe the complex object themselves.

The OpenGL Utility Library

One benefit of a low-level API is that there are no requirements on

how an application must represent or describe higher-level objects

(since there is no notion of such objects in the API). Adherence to

this principle means that the basic OpenGL API does not support

some geometric objects that are traditionally associatedwith graph-

ics APIs. For instance, an OpenGL implementation need not render

concave polygons. One reason for this omission is that concave

3



An Interactive Introduction to OpenGL Programming

10

10

GLUT

GLU

GL

GLX, AGL

or WGL

X, Win32, Mac O/S

software and/or hardware

application program

OpenGL Motif

widget or similar

The above diagram illustrates the relationships of the various libraries and

window system components.

Generally, applications which require more user interface support will use a

library designed to support those types of features (i.e. buttons, menu and scroll

bars, etc.) such as Motif or the Win32 API.

Prototype applications, or ones that don’t require all the bells and whistles of a

full GUI, may choose to use GLUT instead because of its simplified

programming model and window system independence.

GLU (Open GL Utility Library)
Funzioni composte e d’utilità
NURBS, tesselators, Viewpoint ...

AGL, GLX, WGL
“Ponte con sistema operativo e grafico”

GLUT (Open GL Utility Toolkit)
(AGL, GLX, WGL indipendente da S.O)



Libri consigliabili

The OpenGL Programming Guide - The Redbook
The OpenGL Programming Guide 4th Edition The Official Guide to Learning OpenGL 
Version 1.4

The OpenGL Reference Manual - The Bluebook
The OpenGL Reference Manual 4th Edition The Official Reference Document to OpenGL, 
Version 1.4

OpenGL : A Primer (2nd Edition)



Link utili

www.opengl.org
Trovate tutto lì

Tutorial GLUT:
http://www.lighthouse3d.com/opengl/glut/
index.php?2 

Programmi Tutorial Sofisticati
http://www.xmission.com/~nate/
tutors.html

WGL: http://nehe.gamedev.net/



Compilazione (GCC) singolo file

gcc <IncludeDir> <LibDir> <Lib> <Opt>\
    file.c -o file

<IncludeDir> : Non default include directory
             -I <dir1> -I <dir2> ...
             Eg. -I /usr/GLUT/include
                 -I ../include
<LibDir> : Non default libraries directory
           -L <dir1> -L <dir2> ...
           Eg. -L /usr/GLUT/lib
<Lib> : Non default libraries
        -lfile1 -lfile2 ...
        Eg: -lm -lXext -lX11 
            -lGL -lGLU -lglut
    (Apple) -framework OpenGL -framework GLUT
<Opt> : Opzioni varie ed eventuali
        Eg: -g -O2 -DPROVA -Wall

        

           
 



Compilazione (GCC) singolo file

gcc <IncludeDir> <LibDir> <Lib> <Opt>\
    file.c -o file

<IncludeDir> : Non default include directory
             -I <dir1> -I <dir2> ...
             Eg. -I /usr/GLUT/include
                 -I ../include
<LibDir> : Non default libraries directory
           -L <dir1> -L <dir2> ...
           Eg. -L /usr/GLUT/lib
<Lib> : Non default libraries
        -lfile1 -lfile2 ...
        Eg: -lm -lXext -lX11 
            -lGL -lGLU -lglut
    (Apple) -framework OpenGL -framework GLUT
<Opt> : Opzioni varie ed eventuali
        Eg: -g -O2 -DPROVA -Wall

        

           
 

Ubuntu Linux: 
     gcc -g -lGL -lGLU -lglut main.c -o main

MacOSX: 
     gcc -g -framework OpenGL -framework GLUT \    
        main.c -o main



Compilazione (GCC) file multipli

Per ogni file sorgente:
gcc -c <IncludeDir> <CompOpt> file1.c
gcc -c <IncludeDir> <CompOpt> file2.c
...
-> file1.o file2.o ... 

Per l’eseguibile:
gcc <LibDir> <Lib> <LinkOpt>\
    file1.o file2.o ... -o exefile

Conviene fare Makefile:
Vedere Esempi e Tutors



Compilazione (GCC) file multipli

Per ogni file sorgente:
gcc -c <IncludeDir> <CompOpt> file1.c
gcc -c <IncludeDir> <CompOpt> file2.c
...
-> file1.o file2.o ... 

Per l’eseguibile:
gcc <LibDir> <Lib> <LinkOpt>\
    file1.o file2.o ... -o exefile

Conviene fare Makefile:
Vedere Esempi e Tutors

HEADERS  = glm.h materials.h
SOURCES  = fog.c glm.c lightmaterial.c lightposition.c projection.c shapes.c \
           texture.c transformation.c
DEPENDS  = $(SOURCES:.c=.d)
OBJECTS  = $(SOURCES:.c=.o)
PROGRAMS = fog lightmaterial lightposition projection shapes texture \
           transformation

ifdef DEBUG
OPTFLAGS = -g
else
OPTFLAGS = -O3 -s
endif

CC      = gcc
CFLAGS  = -Wall -Wno-format $(OPTFLAGS)
LDFLAGS = -lgl -lglut

all: $(PROGRAMS)

$(PROGRAMS):
	

 $(CC) $(CFLAGS) $^ $(LDFLAGS) -o $@

define PROGRAM_template
$(1): $(addsuffix .o,$(1)) glm.o
endef
$(foreach t,$(PROGRAMS),$(eval $(call PROGRAM_template,$(t))))

clean:
	

 $(RM) $(OBJECTS) $(DEPENDS)
	

 $(RM) $(PROGRAMS)

.PHONY: all clean

%.o: %.c
	

 $(CC) -c $(CFLAGS) $< -o $@

%.d: %.c
	

 $(CC) -MM $(CFLAGS) $< > $@

ifneq ($(MAKECMDGOALS),clean)
-include $(DEPENDS)
endif



Progetto Visual Studio
http://csf11.acs.uwosh.edu/cs371/visualstudio/
http://www.css.tayloru.edu/~btoll/resources/graphics/opengl/xp/
visualc.html

0.  Install GLUT

1. Create an empty C++ Win32 Console Project.

2. Add at least one source file to your project.

3A. Open the project's Property Pages dialog and select All 
Configurations from the Configuration: list box.

4A. .NET: In the Linker → Input subtree, add the following to the 
Additional Dependencies text box:
opengl32.lib glu32.lib glut32.lib

4B. VS7: Select "Settings..." from the "Project" menu
           Select the "Link" tab
           Scroll to the end of the "Object/library models:" text box and add the following 
additional libraries:    glut32.lib glut32.lib opengl32.lib

5OPT. To disable the console window, go to the Linker → Command Line 
subtree and add the following code to the Additional Options: text 
box:
/SUBSYSTEM:WINDOWS /ENTRY:mainCRTStartup



Progetto XCODE
http://razorblade.or.id/2005/10/using-xcode-project-to-do-
manage-your-opengl-applications/

File -> New Project…. 

Command Line Utility -> Standard Tool
(C++ Tool)

Right click on <project> -> Add -> Existing 
Frameworks...
/System/Library/Frameworks
OpenGL.framework
GLUT.framework.



Progetto XCODE
http://razorblade.or.id/2005/10/using-xcode-project-to-do-
manage-your-opengl-applications/

File -> New Project…. 

Command Line Utility -> Standard Tool
(C++ Tool)

Right click on <project> -> Add -> Existing 
Frameworks...
/System/Library/Frameworks
OpenGL.framework
GLUT.framework.



Primo Programma



/* Include GL, GLU & GLUT */
#ifdef WIN32
#include <windows.h>
#include <GL/gl.h>
#include <GL/glu.h>
#include <GL/glut.h>
#endif

#ifdef __APPLE__
#include <OpenGL/gl.h>
#include <OpenGL/glu.h>
#include <GLUT/glut.h>
#endif

#ifdef linux
#include <GL/gl.h>
#include <GL/glu.h>
#include <GL/glut.h>
#endif

/* Include some standard stuff */
#include <stdio.h>
#include <stdlib.h>
#include <math.h>



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

void glutInit(int *argcp, char **argv);

Inizializza la libreria ed la sua interazione con il sistema 
grafico. Se fallisce tutto il programma verrà terminato.



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

void glutInitDisplayMode(unsigned int mode); 

mode: OR di FLAG. Comuni:
GLUT_RGBA     Modalità colore pieno (in genere 32 bit (8: Red 8:Green 8:Blue 8:Alfa)
GLUT_INDEX   Modalità colore indicizzato (o con palette). Ormai poco comune
GLUT_SINGLE Singolo buffer immagine per finestra (Statico)
GLUT_DOUBLE Doppio buffer (Dinamico)
GLUT_DEPTH  Coordinata Z nel buffer (3D + HFR)
....
 
 
 
   (Vedi Manuale)



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

void glutInitWindowSize(int width, int height); 
void glutInitWindowPosition(int x, int y); 



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

int glutCreateWindow(char *name); 

glutCreateWindow crea una nuova finestra top level.

Ritorna un identificatore di finestra per identificarlo in caso si hanno più finestre. 

Esiste il concetto di finestra corrente. Tutte le funzioni GLUT operano su questa.

Per cambiare finestra corrente:
void glutSetWindow(int win);
int glutGetWindow(void);

Vedi anche:
int glutCreateSubWindow(int win,
                        int x, int y, int width, int height);
void glutDestroyWindow(int win);
void glutPositionWindow(int x, int y);
void glutReshapeWindow(int width, int height);
void glutShowWindow(void);
void glutHideWindow(void);
void glutIconifyWindow(void);
void glutSetWindowTitle(char *name);
void glutSetIconTitle(char *name);



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

Callbacks:
GLUT è basato su un modello ad eventi. 
Esiste una coda di eventi. 
Ogni evento è gestito da una funzione a seconda del tipo. Ciclo gestione eventi.
Un programma può registrare le proprie funzioni per una gestione specifica. 

Il ciclo gestione eventi è attivato da:
void glutMainLoop(void);

Tale funzione deve essere chiamata solo una volta nel programma GLUT.
Una volta chiamato non ritornerà mai. Tuttavia chiamerà le funzioni di callback registrate.



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

void glutDisplayFunc(void (*func)(void));

Installa void func() come callback di visualizzazione per la finestra corrnete. 

Quando GLUT determina che la finestra deve essere (ri)-disegnate func è chiamata. 

Si può forzare GLUT a ridisegnare una finestra da un’altro callback con glutPostRedisplay.

Questo callback deve essere fornito a GLUT.



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

void glutReshapeFunc(void (*func)(int width, int height));

Installa void func(int width, int height) come callback di reshape (ridimensionamento). 
Tale callback è chiamato ogni qual volta è ridimensionata. Viene chiamata anche quando la finestra è 
creata. 

Non è necessario registrarla. Esiste una di default. Tuttavia per programmi openGL non banali 
occorre registrarne una nuova.

Se una finestra contiene sotto-finestre, queste non sono ridimensionate automaticamente. Tale 
compito è responsabilità del callback della finestra padre. Se la finestra padre modifica le dimensioni 
di una finestra figlia, l’evento di ridimensionamento è messo in coda per la finestra figlia. 



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);

/* Initial parameters */
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_SINGLE);
glutInitWindowSize(800, 600);

   glutInitWindowPosition(0, 0);

/* Create main Window */
glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}

void glutKeyboardFunc(void (*func)(unsigned char key,
                                   int x, int y));
Installa void (*func)(unsigned char key, int x, int y) comme callback per la 
tastiera. Se l’utente digita sulla finestra questa funzione è chiamata. 

key è il codice ascii del tasto. 
x y sono le coordinate correnti del mouse.

int glutGetModifiers(void) può essere chiamata per determinare eventuali tasti 
modificatori (control, alt, ....).

Per caratteri non ascii esiste la void glutSpecialFunc(void (*func)(int key, int x, 
int y));





int perspective=0;
void reshape(int w, int h) {


/* Current aspect ratio */
float ratio=((float) w) / ((float) h);

      /* Set viewport */
glViewport(0, 0, w, h);

/* Projection Matrix */
glMatrixMode(GL_PROJECTION);

/* Load identity */
glLoadIdentity();

/* The projection */
if (!perspective) {

/* Orthografic */
/* Keep 1:1 ratio, shortest side must be at least [-1,1] */
if (ratio>1) glOrtho( -ratio, ratio, -1, 1, 1, 50);
else glOrtho( -1, 1, -1/ratio, 1/ratio, 1, 50);

} else {
/* OR Perspective */
gluPerspective(35, ratio, 1, 50 );

}

/* Redraw this window */
glutPostRedisplay();

}



int perspective=0;
void reshape(int w, int h) {


/* Current aspect ratio */
float ratio=((float) w) / ((float) h);

      /* Set viewport */
glViewport(0, 0, w, h);

/* Projection Matrix */
glMatrixMode(GL_PROJECTION);

/* Load identity */
glLoadIdentity();

/* The projection */
if (!perspective) {

/* Orthografic */
/* Keep 1:1 ratio, shortest side must be at least [-1,1] */
if (ratio>1) glOrtho( -ratio, ratio, -1, 1, 1, 50);
else glOrtho( -1, 1, -1/ratio, 1/ratio, 1, 3);

} else {
/* OR Perspective */
gluPerspective(35, ratio, 1, 50 );

}

/* Redraw this window */
glutPostRedisplay();

}

void glMatrixMode( GLenum mode )

Specifica lo stack di matrici su cui si applicano le prossime operazioni:

GL_MODELVIEW, GL_PROJECTION, and GL_TEXTURE.

void glViewport( GLint x, GLint y, GLsizei width, GLsizei height )

Imposta l’area della finestra da disegnare con OpenGL.

Implicitamente imposta anche la matrice di trasformazione di dispositivo:

[-1,1]x[-1,1] -> [0, h] x [w, 0]



int perspective=0;
void reshape(int w, int h) {


/* Current aspect ratio */
float ratio=((float) w) / ((float) h);

      /* Set viewport */
glViewport(0, 0, w, h);

/* Projection Matrix */
glMatrixMode(GL_PROJECTION);

/* Load identity */
glLoadIdentity();

/* The projection */
if (!perspective) {

/* Orthografic */
/* Keep 1:1 ratio, shortest side must be at least [-1,1] */
if (ratio>1) glOrtho( -ratio, ratio, -1, 1, 1, 50);
else glOrtho( -1, 1, -1/ratio, 1/ratio, 1, 3);

} else {
/* OR Perspective */
gluPerspective(35, ratio, 1, 50 );

}

/* Redraw this window */
glutPostRedisplay();

}

void glOrtho( GLdouble left, GLdouble right, GLdouble bottom, GLdouble top, GLdouble near, GLdouble far )



int perspective=0;
void reshape(int w, int h) {


/* Current aspect ratio */
float ratio=((float) w) / ((float) h);

      /* Set viewport */
glViewport(0, 0, w, h);

/* Projection Matrix */
glMatrixMode(GL_PROJECTION);

/* Load identity */
glLoadIdentity();

/* The projection */
if (!perspective) {

/* Orthografic */
/* Keep 1:1 ratio, shortest side must be at least [-1,1] */
if (ratio>1) glOrtho( -ratio, ratio, -1, 1, 1, 50);
else glOrtho( -1, 1, -1/ratio, 1/ratio, 1, 3);

} else {
/* OR Perspective */
gluPerspective(35, ratio, 1, 50 );

}

/* Redraw this window */
glutPostRedisplay();

}void gluPerspective( GLdouble fovy, GLdouble aspect, GLdouble zNear, GLdouble zFar )



void display(void) {
/* Clear Buffer */
glClear(GL_COLOR_BUFFER_BIT | GL_DEPTH_BUFFER_BIT);

/* Position Model */
position();

/* Draw model */
axes();

/* Start drawing if you haven't */
glFlush();

}



void display(void) {
/* Clear Buffer */
glClear(GL_COLOR_BUFFER_BIT | GL_DEPTH_BUFFER_BIT);

/* Position Model */
position();

/* Draw model */
axes();

/* Start drawing if you haven't */
glFlush();

}

void glClear( GLbitfield mask )

GL_COLOR_BUFFER_BIT 

GL_DEPTH_BUFFER_BIT

GL_ACCUM_BUFFER_BIT

GL_STENCIL_BUFFER_BIT

void glFlush( void )



void position() {
glMatrixMode(GL_MODELVIEW);
glLoadIdentity();
gluLookAt( 2, 2, 2, 0, 0, 0, 1, 0, 0 );

}







void keyboard(unsigned char key, int x, int y) {
/* Things to remember between calls */
static int fullscreen=0;
static int old_w,old_h;
static int old_x,old_y;
switch(key) {

/* Q or esc: Quit */
case 27:
case 'q':
case 'Q':

exit(0);
break;

/* F: Fullscreen toogle */
case 'f':
case 'F':

/* Not in full screen */
if (!fullscreen) {

/* Save window size and position */
old_w=glutGet(GLUT_WINDOW_WIDTH);

 

old_h=glutGet(GLUT_WINDOW_HEIGHT);
old_x=glutGet(GLUT_WINDOW_X);
old_y=glutGet(GLUT_WINDOW_Y);
/* Go fullscreen */
glutFullScreen();

} else {



            /* Set window size and shape to original values */
        glutReshapeWindow(old_w, old_h);
        glutPositionWindow(old_x, old_y);
        fullscreen=0;

   }
   glutPostRedisplay();
   break;
/* p: Perspective */
case 'p':
case 'P':

perspective=1;
/* Call reshape */
reshape(glutGet(GLUT_WINDOW_WIDTH),  glutGet
(GLUT_WINDOW_HEIGHT));
glutPostRedisplay();
break;

case 'o':
case 'O':

perspective=0;
reshape(glutGet(GLUT_WINDOW_WIDTH),  glutGet
(GLUT_WINDOW_HEIGHT));
glutPostRedisplay();
break;

}
}
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glVertex3fv( v )

Number of

components

2 - (x,y)

3 - (x,y,z)

4 - (x,y,z,w)

Data Type

b - byte

ub - unsigned byte

s - short

us - unsigned short

i - int

ui - unsigned int

f - float

d - double

Vector

omit “v” for

scalar form

glVertex2f( x, y )

The OpenGL API calls are designed to accept almost any basic data type, which

is reflected in the calls name. Knowing how the calls are structured makes it

easy to determine which call should be used for a particular data format and

size.

For instance, vertices from most commercial models are stored as three

component floating point vectors. As such, the appropriate OpenGL command

to use is glVertex3fv( coords ).

As mentioned before, OpenGL uses homogenous coordinates to specify

vertices. For glVertex*() calls which don’t specify all the coordinates

( i.e. glVertex2f()), OpenGL will default z = 0.0, and w = 1.0 .



/* Draw standard Axis */
void axes() {

int i;

/* Data for just the standandard X axis */
/* Others will be permutation on coordinates */
GLfloat axis[][3] =   {  { -1  , 0    , 0     },

                    { 1   , 0    , 0     },
                    { 0.9 , 0.1  , 0     },
                    { 0.9 , -0.1 , 0     },

                { 1   , 0    , 0     },
           { 0.9 , 0    , 0.1   },
           { 0.9 , 0    ,  -0.1 },
           { 1   , 0    ,   0   } };

/* X axis */
 

glColor3ub(255, 0, 0);
glBegin(GL_LINE_STRIP);
//for(i=0;i<8;i++) glVertex3f(axis[i][0],axis[i][1],axis[i][2]);
for(i=0;i<8;i++) glVertex3fv(axis[i]);
glEnd();

/* Y axis */
glColor3ub(0, 255, 0);
glBegin(GL_LINE_STRIP);
for(i=0;i<8;i++) glVertex3f(axis[i][2],axis[i][0],axis[i][1]);
glEnd();

/* Z axis */
glColor3ub(0, 0, 255);
glBegin(GL_LINE_STRIP);
for(i=0;i<8;i++) glVertex3f(axis[i][1],axis[i][2],axis[i][0]);
glEnd();

}



Trasformazioni





Stack Matrici su cui operare
void glMatrixMode( GLenum mode )
GL_MODELVIEW, GL_PROJECTION, and GL_TEXTURE.

Carica Matrice identità
void glLoadIdentity( void )

Carica matrice
void glLoadMatrixd( const GLdouble *m )
void glLoadMatrixf( const GLfloat *m )

Multiplica per matrice
void glMultMatrixd( const GLdouble *m )
void glMultMatrixf( const GLfloat *m )
glMultMatrix multiplies the current matrix with the one specified in m. That is, if M is the 

current matrix and T is the matrix passed to glMultMatrix, then M is replaced with MT.



void glRotated( GLdouble angle, GLdouble x, GLdouble y, GLdouble z )
void glRotatef( GLfloat angle, GLfloat x, GLfloat y, GLfloat z )

void glScaled( GLdouble x, GLdouble y, GLdouble z ) 
void glScalef( GLfloat x, GLfloat y, GLfloat z )

void glTranslated( GLdouble x, GLdouble y, GLdouble z )
void glTranslatef( GLfloat x, GLfloat y, GLfloat z )



C SPECIFICATION
void glPushMatrix( void )

void glPopMatrix( void )

DESCRIPTION

There is a stack of matrices for each of the matrix modes. In 
GL_MODELVIEW mode, the stack depth is at least 32. In the other two 
modes, GL_PROJECTION and GL_TEXTURE, the depth is at least 2. 
The current matrix in any mode is the matrix on the top of the stack for that 
mode.

glPushMatrix pushes the current matrix stack down by one, duplicating 
the current matrix. That is, after a glPushMatrix call, the matrix on the top 
of the stack is identical to the one below it.

glPopMatrix pops the current matrix stack, replacing the current matrix 
with the one below it on the stack.



Secondo Programma



int main (int argc, const char** argv) {

/* Init Glut */
glutInit(&argc, argv);
glutInitDisplayMode(GLUT_RGB | GLUT_DEPTH | GLUT_DOUBLE);

/* Main Window */
   glutInitWindowSize(800, 600);
   glutInitWindowPosition(0, 0);

glutCreateWindow("Axes");

/* Set Callbacks */
glutDisplayFunc(display);
glutReshapeFunc(reshape);
glutKeyboardFunc(keyboard);
glutMouseFunc(mouse);
glutMotionFunc(mousemotion);

    
/* Glut Main Loop */
glutMainLoop();

/* Never reached, keep compiler happy */
return 0;

}



void display(void) {

 


 /* Clear Buffer */

 glClear(GL_COLOR_BUFFER_BIT | GL_DEPTH_BUFFER_BIT);

 glEnable(GL_DEPTH_TEST);


 position();


 axes();



 /* Draw model */

 model();



 /* SwapBuffer */

 glutSwapBuffers();
}



void model() {

 GLfloat light_pos[]={ 2.0, 2.0, 3.0 };


 /* Fiat Lux */

 glEnable(GL_LIGHTING);

 glEnable(GL_LIGHT0);

 glLightfv(GL_LIGHT0, GL_POSITION, light_pos );



 /* Animated move */
  moveposition();



 /* Model */

 glColor3ub(100, 100, 100);

 glutSolidTeapot(1);



 /* Goto darkness */

 glDisable(GL_LIGHTING);
}



struct Viewpoint {

 GLfloat center[3];
  GLfloat alpha;

 GLfloat beta;

 GLfloat gamma;

 GLfloat zoom;
};
struct Viewpoint init_viewpoint = { { 0, 0, 0}, 0, 0, 0, 1}; 
struct Viewpoint viewpoint = { { 0, 0, 0}, 0, 0, 0, 1}; 

enum Motion_mode { NONE=0, ROTATE, DIST,  PAN };

struct Motion { 

 int mode;

 int startx;

 int starty;
};

struct Motion motion = { NONE, 0, 0 };



void mouse(int button, int state, int x, int y) {

 if(state==GLUT_DOWN) {

 
 motion.startx=x;

 
 motion.starty=y;


 
 switch (button) {

 
 
 case GLUT_LEFT_BUTTON:

 
 
 
 motion.mode=ROTATE;

 
 
 
 break;

 
 
 case GLUT_MIDDLE_BUTTON:

 
 
 
 motion.mode=DIST;

 
 
 
 break;

 
 
 case GLUT_RIGHT_BUTTON:

 
 
 
 motion.mode=PAN;

 
 
 
 break;

 
 
 default:

 
 
 
 motion.mode=NONE;

 
 }

 } else { 

 
 motion.mode=NONE;

 }

 

}



void mousemotion(int x, int y) {



 switch (motion.mode) {

 


 
 case ROTATE:

 
 
 viewpoint.alpha+=(GLfloat) ((x-motion.startx) % 360);

 
 
 viewpoint.beta+=(GLfloat) ((y-motion.starty) % 360);

 
 
 break;

 
 case DIST:

 
 
 viewpoint.zoom+=4.0 * ((GLfloat) (y-motion.starty))/((GLfloat) glutGet(GLUT_WINDOW_HEIGHT));

 
 
 break;

 
 case PAN:

 
 
 viewpoint.center[0]+=4.0 * ((GLfloat) (x-motion.startx)) / ((GLfloat) glutGet(GLUT_WINDOW_WIDTH));

 
 
 if(glutGetModifiers()==GLUT_ACTIVE_SHIFT) { // Non funge!!!

 
 
 
 viewpoint.center[2]-=4.0 * ((GLfloat) (y-motion.starty)) / 
                                      ((GLfloat) glutGet(GLUT_WINDOW_HEIGHT));

 
 
 } else { 

 
 
 
 viewpoint.center[1]-=4.0 * ((GLfloat) (y-motion.starty)) / 
                                      ((GLfloat) glutGet(GLUT_WINDOW_HEIGHT));

 
 
 }

 
 
 break;

 
 default:

 
 
 break;

 }



 motion.startx=x;

 motion.starty=y;



 glutPostRedisplay();
}



void moveposition() {

 glMatrixMode(GL_MODELVIEW);



 glTranslatef(viewpoint.center[0]-viewpoint.center[2], 

              viewpoint.center[1],

 
 
 
  viewpoint.center[2]-viewpoint.center[0]

 
 
 
  );

 glRotatef(viewpoint.beta, cos(M_PI_4), 0, -sin(M_PI_4) );

 glRotatef(viewpoint.alpha, 0, 1, 0 );

 glScalef( viewpoint.zoom, viewpoint.zoom, viewpoint.zoom);
}


